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Preface
This guide, which explains how to install Kofax RPA in a development environment, covers both
interactive and "silent" installation procedures for Windows, as well as standard and "headless"
procedures for Linux.
Note If you plan to install Kofax RPA in a production environment, see the Administrator's Guide.
In a production environment, we strongly recommend deployment of the Management Console on a
stand-alone Tomcat server. This recommendation is based on, but not limited to the following.
• Derby is used as a system database in embedded mode, which is not recommended for production
environment.
• A Management Console on Tomcat:
• Can use an enterprise class database for improved performance and data security.
• Can integrate with LDAP and SAML.
• Tomcat can be configured to customer requirements.
Before installing Kofax RPA, you must decide whether to install the 32-bit or the 64-bit version. The key
issues to consider are:
• Your operating system may only support one of the versions. 64-bit Windows supports both. On Linux,
only the 64-bit version is supported.
• The 64-bit version is mainly useful on servers where you want to run a RoboServer that uses significant
RAM. (You will need to configure the allowed amount of RAM after installation, as described in the
"Changing the RAM Allocation" section in the Administrator's Guide).
This guide describes:
• How to install Kofax RPA, either interactively or "silently" (without user interaction).
• How to enter license information so that you can start Kofax RPA.
• How to configure Kofax RPA.
• How to set up Kofax RPA server applications to start automatically when the computer restarts.
• How to upgrade from earlier versions.

Related Documentation
1

The documentation set for Kofax RPA is available here:

https://docshield.kofax.com/Portal/Products/RPA/10.6.0_p2wddr4n2j/RPA.htm

1

You must be connected to the Internet to access the full documentation set online.
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You can also access individual guides and online help directly from your Kofax RPA installation. When you
click the help button in Design Studio, Management Console, Desktop Automation Service, and Process
Discovery, online documentation appears in a new browser window.
Note If the security policy for your organization restricts Internet access or the Internet connection is not
stable, you can access the documentation in offline mode while using the product.
In addition to this guide, the documentation set includes the following items:
Kofax RPA Release Notes
Contains late-breaking details and other information that is not available in your other Kofax RPA
documentation.
Kofax RPA Administrator's Guide
Describes administrative and management tasks in Kofax RPA.
Help for Kofax RPA
Describes how to use Kofax RPA. The Help is also available in PDF format under the title of Kofax RPA
User's Guide.
Kofax RPA Getting Started with Desktop Automation Guide
Provides a tutorial that walks you through the process of using Kofax RPA Desktop Automation to build a
robot.
Kofax RPA Getting Started with Document Transformation Guide
Provides a tutorial that explains how to use Document Transformation functionality in a Kofax RPA
environment, including OCR, classification, extraction, field formatting, and validation.
Kofax RPA Desktop Automation Service Configuration Guide
Describes how to configure the Desktop Automation Service required to use Desktop Automation on a
remote computer.
Kofax RPA Developer's Guide
Contains information on the API that is used to execute robots on the RoboServer.
Kofax RPA Integration API documentation
Contains information about the Kofax RPA Java API and the Kofax RPA .NET API, which provide
programmatic access to the Kofax RPA product. The Java API documentation is available from both the
online and offline Kofax RPA documentation, while the .NET API documentation is available only offline.
Note The Kofax RPA APIs include extensive references to RoboSuite, the original product name. The
RoboSuite name is preserved in the APIs to ensure backward compatibility. In the context of the API
documentation, the term RoboSuite has the same meaning as Kofax RPA.
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Offline Documentation
To make the documentation available for use in offline mode, obtain the documentation files from the
Kofax RPA product package that you downloaded from the Kofax Fulfillment Site. The product package
includes the following documentation files for offline use:
• KofaxRPADocumentation_10.6.0_EN.zip
Contains the entire Kofax RPA documentation set in English. This file is required for all users who work
in offline mode.
• KofaxRPADocumentation_10.6.0_JA.zip
Contains the Kofax RPA documentation set that is available in Japanese. At this time, the following
documentation is translated to Japanese: Help for Kofax RPA (also available in PDF format as Kofax
RPA User's Guide), Kofax RPA Desktop Automation Service Guide, and Kofax RPA Getting Started
with Document Transformation Guide.
After you install the Kofax RPA product, extract the contents of the documentation .zip files for the
languages you require. The .zip file for each language contains the following folders:
• API
• Design Studio
• Desktop Automation Service
• Management Console
• Process Discovery
After you extract the files, the documentation folder for Design Studio, Desktop Automation Service, and
Process Discovery will have the following structure:
• documentation
• EN and/or JA (for English and Japanese, respectively)
• print and/or help (for PDF documentation and Help for Kofax RPA, respectively)
For the Management Console, there are no documentation or language code folders, and only the
ManagementConsoleHelp.war file will be added to the Management Console program files.
When the offline documentation is installed for an RPA component according to the instructions below,
the component will use the offline version of the documentation by default, even if an active Internet
connection exists.
Offline API documentation
The API folder contains the API references in English.
1. Copy the API folder from the English .zip file extracted above to any folder on your computer.
2. In this folder, double-click Overview.html to open the API documentation.
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Offline documentation for Design Studio
1. Open the Design Studio folder from the English .zip file extracted above and copy the EN folder to
one of the following folders, depending on your installation:
• C:\Program Files(x86)\Kofax RPA 10.6.0.0 x32\documentation
• C:\Program Files(x86)\Kofax RPA 10.6.0.0 x64\documentation
2. If you require the Japanese documentation, open the Design Studio folder from the Japanese .zip
file extracted above and copy the JA folder to the same location.
3. Start Design Studio and navigate to Settings > Design Studio Settings.
4. On the General tab, in Documentation location, select Offline in the list.
5. Save the changes.
To switch to online mode, select Online in Design Studio Settings and save the changes.
Note If you try to access the online documentation from Kofax RPA without Internet access, the
Retrieving help and documentation warning is displayed. If you select Do not show this notification
again and later you want to reset this option, select Show documentation retrieval notifications on
the General tab in Design Studio Settings.
Offline documentation for Management Console
1. Open the Management Console folder from the English .zip file extracted above and copy the
ManagementConsoleHelp.war file to:
C:\<Tomcat installation folder>\Tomcat <version>\webapps
Note The English and Japanese .zip files contain the same .war file, which includes both English
and Japanese documentation. If you copied the .war file from the English .zip file and you require
the Japanese version of documentation, no further actions are needed.
2. Start the Management Console.
3. On the Admin tab, in the Settings section, open the Base URL settings.
4. Select Use local documentation. In Local Documentation base URL, specify the URL to the
Tomcat website containing the documentation.
Example: http://localhost:8080/ManagementConsoleHelp/
5. Save the changes.
You may need to refresh the Management Console for the changes to take effect.
To switch to online mode, clear Use local documentation in the Base URL settings and save the
changes.
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Offline documentation for Desktop Automation Service
1. In the following folder, create a new folder called documentation.
C:\Program Files(x86)\RPA DesktopAutomation 10.6.0.0 x32\documentation
2. Open the Desktop Automation Service folder from the English .zip file extracted above and
copy the EN folder to the newly created documentation folder.
3. If you require the Japanese documentation, open the Desktop Automation Service folder from
the Japanese .zip file extracted above and copy the JA folder to the same location.
To switch to online mode, delete or move the documentation folder from the RPA
DesktopAutomation 10.6.0.0 x32 folder.
Offline documentation for Process Discovery
1. In each of the following folders, create a new folder called documentation.
• C:\Program Files (x86)\Kofax RPA Process Discovery Agent 10.6.0.0 x32
• C:\Program Files (x86)\Kofax RPA Process Discovery Analyzer 10.6.0.0 x32
2. Open the Process Discovery folder from the English .zip file extracted above and copy the EN
folder to the newly created documentation folders.
3. If you require the Japanese documentation, open the Process Discovery folder from the
Japanese .zip file extracted above and copy the JA folder to the same locations.
To switch to online mode, delete or move the documentation folder from the Kofax RPA Process
Discovery Agent 10.6.0.0 x32 and Kofax RPA Process Discovery Analyzer 10.6.0.0
x32 folders.

Training
Kofax offers both classroom and computer-based training to help you make the most of your Kofax RPA
solution. Visit the Kofax website at www.kofax.com for details about the available training options and
schedules.

Getting help with Kofax products
The Kofax Knowledge Base repository contains articles that are updated on a regular basis to keep you
informed about Kofax products. We encourage you to use the Knowledge Base to obtain answers to your
product questions.
To access the Kofax Knowledge Base, go to the Kofax website and select Support on the home page.
Note The Kofax Knowledge Base is optimized for use with Google Chrome, Mozilla Firefox or Microsoft
Edge.
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The Kofax Knowledge Base provides:
• Powerful search capabilities to help you quickly locate the information you need.
Type your search terms or phrase into the Search box, and then click the search icon.
• Product information, configuration details and documentation, including release news.
Scroll through the Kofax Knowledge Base home page to locate a product family. Then click a product
family name to view a list of related articles. Please note that some product families require a valid
Kofax Portal login to view related articles.
• Access to the Kofax Customer Portal (for eligible customers).
Click the Customer Support link at the top of the page, and then click Log in to the Customer Portal.
• Access to the Kofax Partner Portal (for eligible partners).
Click the Partner Support link at the top of the page, and then click Log in to the Partner Portal.
• Access to Kofax support commitments, lifecycle policies, electronic fulfillment details, and self-service
tools.
Scroll to the General Support section, click Support Details, and then select the appropriate tab.
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Dependencies and Prerequisites
This chapter lists components and required configuration settings to use different Kofax RPA features. For
supported platforms and versions, see the Kofax RPA Technical Specifications document on the Kofax
website.
Real-time data: If you have a solution where users are waiting for results in real-time, CPU speed is
normally the bottleneck, and you should buy the fastest CPU available for your hardware platform.
Dedicated hardware: For best performance, we recommend that you always run RoboServer,
Management Console, or Document Transformation Service each on dedicated hardware. That means
that you should not run database servers and other services on the same hardware with your RoboServer,
Management Console, or Document Transformation Service.
Any email field in Kofax RPA can contain up to 255 characters. Do not exceed the number of characters in
the email field.
Linux installation dependencies
When installing on Ubuntu, Ubuntu 14.04 LTS with libqt5webkit5 library is required.
The minimal Linux installation must include the following libraries to be able to run robots created with the
default browser engine.
• libX11.so.6
• libGL.so.1
• libXext.so.6
To use cross-platform authentication (Negotiate and NTLM protocols), your Linux installation must include
these Generic Security Service API (GSS-API) libraries:
• libgssapi_krb5.so.2
• libgssapi.so.4
• libgssapi.so.2
• libgssapi.so.1
Note Kofax RPA supports libssl1.0.2 or below.
Use the yum install or sudo apt-get command to install necessary libraries on a Linux platform.
You must also install fonts on a headless Linux server for the WebKit robots to work.
• Instructions for installing fonts for CentOS / RedHat
• Instructions for installing fonts for Ubuntu
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Databases
Important Please create and maintain the Kofax RPA product databases according to the
recommendations in the product documentation. If you are considering database modifications or
customizations, do not proceed without consulting Kofax; otherwise, the results are unpredictable and
the software may become inoperable.
You can use Microsoft SQL Server with integrated Windows Authentication as a logging (logdb) database
only in the following cases:
Important Microsoft SQL Server with integrated Windows Authentication cannot be used as a logging
(logdb) database when you run Management Console and RoboServer in embedded mode.
Also make sure that SQL Server Authentication of the Microsoft SQL Server is disabled.
• Both Management Console and RoboServer must run only on a Windows platform.
• Management Console must be installed on a Tomcat server.
• The JDBC driver, including DLLs, must be manually installed into both Management Console and all
RoboServer installations without using the JDBC distribution mechanism in the Management Console.
Oracle Connection URL must use ${ServerName}:${Schema}. Using ${ServerName}:
${ServiceName} is not supported.
You can use PostgreSQL database only for storing your data. PostgreSQL cannot be used as a
Management Console system, logging, or audit database.
Be aware that loss of data may occur when storing data in Oracle, Sybase or MySQL. On Oracle, an
empty string is converted to null. On Sybase, an empty string is converted to " " (a single space). On
MySQL, millisecond precision is lost when storing dates. For details, see the ObjectKey Caveats section
in the Storing Data in Databases topic in the Kofax RPA help.
Note For correct display of data in the Kofax Insight Dashboard, make sure Java correctly sets the
time according to your time zone on RoboServers and computers running Management Consoles. See
the Timezone Data Versions in the JRE Software on the Oracle web site for the latest updates in time
zones. If necessary, use the Timezone Updater Tool to update the time zone information.
Document Transformation prerequisites and limitations
Install all the latest Windows updates before installing and using Kofax RPA Document Transformation.
Prerequisites
The maximum document size for transformation is 100 MB. Kofax RPA imposes a file size limit for a
transformed document to enable protection against the denial-of-service attacks. You can lower the
file size value to protect against such an attack. To change the document size limit, edit the following
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parameter in the Web.config file in the Kofax DTS\Transformation Services directory in the
Kofax RPA installation folder.
<httpRuntime targetFramework="4.5.1" maxRequestLength="104857600"/>
The following are other requirements you need to observe.
• Do not install Kofax RPA Document Transformation on the computer running Kofax Transformation
or Kofax TotalAgility.
• You can re-use existing KTM, KTT, and RTTI projects version 6.2 or earlier.
• You cannot re-use KTA projects, because KTA does not provide a way to export a KTA Extraction/
Classification group to a complete .fpr file.
Limitations
The following Kofax Transformation features are not supported.
• Rich client user modules (Doc Review, Validation, Verification, Correction)
• ThinClient user modules other than validation (Verification and Correction)
• Multiple steps of Validation
• Configuration Sets for migration between systems
• A2iA engines
• Reporting settings
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Desktop Automation requirements and prerequisites
Desktop Automation on Windows
If you get the error: "Module automationnative not found," install the following update.
https://support.microsoft.com/en-us/kb/2999226
If the Windows update is not available on your system, use the following workaround.
1. Create a c:\temp\976571 folder.
2. Use the following command to extract the contents of the MSU file:
Expand -F:* c:\kb976571\Windows6.1-KB976571-v2-x64.msu c:\temp\976571
This command extracts multiple files, from Windows6.1-KB976571-v2-x64.cab.

3. Run the following command:
DISM.exe /Online /Add-Package /PackagePath:c:\temp\976571\Windows6.1KB976571-v2-x64.cab
For more information, see How to use DISM to install a hotfix from within Windows on the Microsoft
Technet website https://blogs.technet.microsoft.com.
The following sections list components that must be installed and configured on the automation devices
(remote computers you want to automate) before you can use the Desktop Automation feature in Kofax
RPA.
Java Access Bridge
To automate Java programs or Java applets on remote devices with Kofax RPA, install Java 32-bit on
your device (JRE or JDK) and enable the Java Access Bridge in the Java Runtime Environment used
by the application. We recommend using the latest available Java version.
For JRE 7 or Later
To enable Java Access Bridge for Java version 7 or later, navigate to the bin directory in the Java
installation directory and run the following command.
jabswitch -enable

For JRE6
Follow this procedure to install Java Access Bridge 2.0.2 on a Windows 32-bit system. For older
applications that require Java version 1.6, copy the following files to the specified destination
directories, where %WINDOWSHOME% is the directory where Microsoft Windows is installed (for
example, C:\WINDOWS), and %JAVAHOME% is the directory where your JDK or JRE is installed.
The following are examples of directory names for Java SE 6 Update 24.
• JDK: C:\Program Files\Java\jdk1.6.0_24\jre
• JRE: C:\Program Files\Java\jre6
The following table lists Java Access Bridge Windows libraries and related files for Windows 32-bit
systems.
Java Access Bridge File

Destination Directory

WindowsAccessBridge.dll

%WINDOWSHOME%\SYSTEM32

JavaAccessBridge.dll

%JAVAHOME%\bin

JAWTAccessBridge.dll

%JAVAHOME%\bin

accessibility.properties

%JAVAHOME%\lib

14

Kofax RPA Installation Guide

Java Access Bridge File

Destination Directory

access-bridge.jar

%JAVAHOME%\lib\ext
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Java Access Bridge File

Destination Directory

jaccess.jar

%JAVAHOME%\lib\ext

For more information, search the Downloads page on the Oracle web site ( http://www.oracle.com/
technetwork/java/javase/downloads/) to locate and download jab-2-0-2. For installation
instructions, see "installing-jab-32-bit" on the http://docs.oracle.com website.
Perform the following to test that you have installed Java Access Bridge properly.
1. Run the SwingSet2 application and then run the JavaMonkey.exe application.
2. Select File > Refresh Tree in the Java Monkey application and the SwingSet2 application
should appear.
Alternatively, you can use the JavaFerret.exe application.
Requirements for Linux-based platforms
To use Desktop Automation, install the libxslt1.1 package.
To use the built-in browser in Desktop Automation on Ubuntu-based distributions, install the following
packages:
• gconf-service
• libasound2
• libatk1.0-0
• libc6
• libcairo2
• libcups2
• libdbus-1-3
• libexpat1
• libfontconfig1
• libgcc1
• libgconf-2-4
• libgdk-pixbuf2.0-0
• libglib2.0-0
• libgtk2.0-0
• libnspr4
• libnss3
• libpango-1.0-0
• libpangocairo-1.0-0
•
•
•
•
•
•
•

libx11-xcb1
libxcb1
libxcomposite1
libxcursor1
libxdamage1
libxfixes3
libxi6
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• libxrandr2
•
•
•
•

libxrender1
libxss1
libxtst6
Xvfb

To use the built-in browser in Desktop Automation on Red Hat and CentOS-based distributions, install
the packages containing the following libraries:
• libX11-xcb.so.1
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

libfontconfig.so.1
libpango-1.0.so.0
libpangocairo-1.0.so.0
libcairo.so.2
libXcomposite.so.1
libXcursor.so.1
libXdamage.so.1
libXfixes.so.3
libXi.so.6
libXrender.so.1
libXtst.so.6
libXrandr.so.2
libXss.so.1
libgconf-2.so.4
libgio-2.0.so.0
libasound.so.2
libcups.so.2
libdbus-1.so.3
libatk-1.0.so.0
libgtk-x11-2.0.so.0
libgdk-x11-2.0.so.0
libgdk_pixbuf-2.0.so.0
libnspr4.so
libnss3.so
libnssutil3.so
libsmime3.so

• libexpat.so.1
• libxcb.so.1
• xorg-x11-server-Xvfb
To use the "Open step" action, which allows an application to open on an automated device with an
RDP connection, install the packages containing the following libraries:
• libc.so.6
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• libxcb.so.1
•
•
•
•
•
•
•

libXext.so.6
libdl.so.2
libpthread.so.0
libm.so.6
libssl.so.1.1
libcrypto.so.1.1.0
libXau.so.6

• libXdmcp.so.6
For more information on this action, see "Open Step" in the Kofax RPA help.
Prerequisites for Internet Explorer
To automate Internet Explorer for use with the Desktop Automation feature, check the following
requirements.
• In Internet Explorer 7 and higher on Windows 7, set the same value (either On or Off) in the
Protected Mode settings for each zone. To open the Protected Mode settings in Internet Explorer,
select Tools > Internet options and click the Security tab. For each zone, select the Enable
Protected Mode option and select the same security level.
• For IE 10 and higher, disable the Enhanced Protected Mode in the Security settings on the
Advanced tab of the Internet Options window.
• For IE 11 only, check that a FEATURE_BFCACHE subkey with a DWORD value named
iexplore.exe is present in the registry on the target computer. This subkey enables the driver
to maintain a connection to the instance of Internet Explorer it creates. For 32-bit Windows,
examine the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\Main
\FeatureControl\FEATURE_BFCACHE key in the registry editor. For 64-bit Windows, examine
the HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Internet Explorer
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\Main\FeatureControl\FEATURE_BFCACHE key. If the FEATURE_BFCACHE subkey is not
present, create it and create a DWORD value named iexplore.exe with the value "0" in the key.
• Set the browser zoom level to 100% to align the native mouse events with the correct coordinates.
Note In some cases, out-of-browser Silverlight applications can interfere with Desktop Automation.
The cause of the problem is the Internet Explorer subdriver. To disable the subdriver, clear the
Extended Internet Explorer Support option on the Windows tab of the Desktop Automation
Service configuration window.
SAP prerequisites
To automate an SAP application for use with the Desktop Automation feature, enable scripting on both
the server and the client sides.
• On the client, go to SAP GUI Options and enable scripting. Also, turn off notifications, because
they interrupt the automation process.
• To enable scripting on the SAP server, perform the following steps. Note that you must have
administrative privileges to change the sapgui/user_scripting parameter.
1. Log on to your SAP server.
2. Run transaction RZ11. Specify the parameter name sapgui/user_scripting and click
Display. If Parameter name is unknown appears in the status bar, it indicates that you
are missing the current support package. Check your installed packages.
3. Change the value to TRUE.
4. Click Save.
Note that some elements, such as scroll bars, are only available if you run the SAP client on a
machine with a Windows Classic desktop theme.
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Install Kofax RPA
This chapter describes how to install Kofax RPA on a single computer in a developer environment. See
the Administrators Guide for installation and deployment in a production environment.
For the Windows platform, Kofax RPA has five installers that install different components of the software:
• Kofax RPA Design Studio installer: Installs Design Studio, but does not install RoboServer,
Management Console or API. Use this installer if you have a central Management Console/License
Server and need a separate copy of Design Studio.
• Kofax RPA RoboServer installer: Installs RoboServer only and does not install Management Console or
Design Studio. This installer is useful, if you need to set up dedicated RoboServer machines.
• Configurable full Kofax RPA installer: Installs all the components, or selected components that you
specify.
• Kofax RPA Desktop Automation installer: Installs the Desktop Automation Agent to automate remote
devices.
• Kofax RPA DTS (Document Transformation Service) installer: Installs Kofax RPA Document
Transformation.
As another option, you can perform a silent installation. If you run a silent installation of the full installer,
you get the "Typical" install. See Silent Installation on Windows for details.
To enable single-computer installation of all components, Kofax also supplies a zip archive that
contains a full Kofax RPA installer, Kofax RPA Desktop Automation installer, Kofax RPA DTS installer,
and Setup.exe file that can install all included components. See Install Document Transformation
Components for details.
For Linux, Kofax RPA provides a full installer as well as rpm and deb packages for installing RoboServer
as a service. See Install on Linux for details.
Upgrade from Earlier Versions
In the interest of stability, different versions of Kofax RPA may be installed side by side on the same
computer without interfering with each other (except that they must be configured to use different port
numbers for the Management Console if run simultaneously). This means that you can install a newer
version and get acquainted with it while still doing your daily work with the older version.
You can copy important data such as uploaded robots, execution schedules and so on from one version of
Management Console to another by making a backup of the old installation and "restoring" it into the new
one. Making a backup varies in different versions of Kofax RPA, so check the help or User's Guide to learn
how to create a backup.
Note Effective since Kofax RPA version 10.3, any admin user can restore a backup created by any other
admin user.
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Install on Windows
The full Kofax RPA installer provides the following installation options. Optional items are listed with an
asterisk.
• Design Studio: Installs Design Studio and its required components
• RoboServer: Installs RoboServer
• Embedded Management Console: Installs components needed to run an embedded Management
Console on the RoboServer
• Management Console: Creates the WAR file for manual installation of the Management Console
• SQL scripts for database tables
• API*: Installs necessary API components
The following files install separate Kofax RPA components.
If you are installing Design Studio only, download and save the
Kofax_RPA_DesignStudio_10.6.0.0_x32.msi or
Kofax_RPA_DesignStudio_10.6.0.0_x64.msi file to your hard disk. After the download is
completed, run the file to start the installation and follow the installer prompts.
To install a RoboServer, download and save the Kofax_RPA_RoboServer_10.6.0.0_x32.msi or
Kofax_RPA_RoboServer_10.6.0.0_x64.msi file to your hard disk. After the download is completed,
run the file to start the installation and follow the installer prompts.
To install the Desktop Automation Service, download and save the
Kofax_RPA_DesktopAutomation_10.6.0.0_x32.msi. After the download is completed, run the file
on the computer you want to automate and follow the installer prompts. For more information, see Install
the Desktop Automation Service.
As another option, you can use the silent installation to automate the installation process.
Note You need administrator rights to install Kofax RPA on Windows.

Install the Desktop Automation Service
To install the Desktop Automation Service, download and save the
Kofax_RPA_DesktopAutomation_10.6.0.0_x32.msi file to your hard disk. After the download
is completed, run the file on the computer you want to automate to start the installation. The Desktop
Automation Service is installed in autostart mode. Note that you do not need to install the Desktop
Automation Service to automate terminals.
Important The Desktop Automation Service version must match the version of other Kofax RPA
components, such as Design Studio and Management Console.
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Install Components for Desktop Automation Service
Desktop Automation Service is designed to automate any work process involving computer applications
on Windows systems. The following components and configuration steps are required for the Desktop
Automation Service to access applications on Windows.
Make sure that the latest Windows operating system updates are installed. For Windows 7, 8, and 8.1,
the KB2999226 update is required. If this update is not installed on your system, download it from the
Microsoft website and install according to the provided instructions.
To work with Java applications, check the following.
• Install the latest Oracle Java 32-bit (JRE or JDK) that installs the Java Access Bridge 32-bit dlls. The
Java applications started by the robots can run in a 64-bit JVM, but the 64-bit installer does not include
the 32-bit dlls. If your corporate policy does not allow upgrading the Oracle Java, manually install the
files needed for Java Access Bridge support as follows.
Java Access Bridge Installation on Windows 64-bit
1. Download Java Access Bridge 2.0.2 from the Java Access Bridge download page at the
following URL:
http://www.oracle.com/technetwork/java/javase/downloads/jab-2-0-2-download-354311.html
2. Extract the Java Access Bridge to a folder in your drive and copy
WindowsAccessBridge-32.dll to [WINDOWSHOME]\SYSWOW64. Where
WINDOWSHOME is the directory where Microsoft Windows is installed, for example, C:
\WINDOWS.
Java Access Bridge Installation on Windows 32-bit
1. Download Java Access Bridge 2.0.2 from the Java Access Bridge download page at the
following URL:
http://www.oracle.com/technetwork/java/javase/downloads/jab-2-0-2-download-354311.html
2. Extract the Java Access Bridge to a folder in your drive and copy
WindowsAccessBridge-32.dll to %WINDOWSHOME%\SYSTEM32. Where %WINDOWSHOME%
is the directory where Microsoft Windows is installed, for example, C:\WINDOWS.
Note For detailed Java Access Bridge installation instructions, see Installing Java Access Bridge on
the Oracle website.
• Enable the Java Access Bridge by selecting the Enable Java Access Bridge option in the Control
Panel > Ease of Access Center > Use the computer without a display or by running the
following command prompt command in the bin subdirectory of the Java JRE installation directory:
jabswitch.exe /enable.

Install Document Transformation Components
This section describes how to install Kofax RPA Document Transformation components on one computer.
See the Kofax Transformation product documentation for installation and configuration details.
The complete Kofax RPA installer is delivered as a .zip file containing the following four components.
• Setup.exe
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• Kofax_RPA_10.6.0.0_x64.msi
This installer contains the Kofax RPA core components:
• Design Studio: the robot design environment
• RoboServer: the robot execution server
• Management Console: an embedded version of the web console
• Git Synchronizer
• Kofax_RPA_DTS_10.6.0.0_x32.msi
This installer contains the Document Transformation components required to run:
• Document Transformation Project Builder
• Kofax Licensing Server
• Document Transformation Services
• Document Transformation Thin Client Server
• Document Transformation Standard Projects
• Document Transformation Service Scheduler
• Kofax_RPA_DesktopAutomation_10.6.0.0_x32.msi
This installer contains the Desktop Automation Service.
By default, the Document Transformation folders are located in c:\Document Transformation.
To access each component documentation, refer to the Related Documentation section in this document.
Refer to the Troubleshooting section below for resolving common issues.
Important Kofax RPA Document Transformation Service and Document Transformation Thin Client
Server require IIS (Internet Information Services) and ASP.NET to be installed. Depending on the
version of Windows, these components are either a Windows feature that can be enabled in the Control
Panel, or they are available as separate downloadable components. For installation and configuration
instructions, see the Kofax Transformation Toolkit Thin Client Server Developer's Guide.
Requirements
• You must have administrator rights on the computer where the Kofax RPA is installed. Disable User
Account Control (UAC) to minimize installation issues.
• Some Windows operating systems disable localhost mapping. Prior to starting this installation, either
enable it by modifying your hosts file or use 127.0.0.1 where localhost is referenced. If you choose to
keep the localhost mapping disabled, modify the Web.config files in the Document Transformation
subfolders after installation is complete.
• Executing the PowerShell scripts, EnableDocumentTransformationWindows7.ps1 and
EnableDocumentTransformationWindows10.ps1, requires PowerShell version 3, which is not always
installed on Windows 7. You can install the required PowerShell version via the Windows Update. For
more information on the scripts, see later in this section.
• Both IIS services, Kofax RPA Document Transformation Service and Document Transformation
Thin Client Server, must have modification privileges on the folders used by the Document
Transformation Service. The PowerShell scripts, EnableDocumentTransformationWindows7.ps1
and EnableDocumentTransformationWindows10.ps1, set these privileges automatically, but if the
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scripts are not used, the IIS application pool users must be explicitly assigned access to the Document
Transformation folders.
• .NET version 4.7 and DirectX are required for the Document Transformation Service.
1. Prior to unzipping the contents of the software archive file, right-click the .zip file and unblock it to
prevent issues during installation. Disregard this step if the Unblock option is not displayed.

2. Unzip the contents of the archive into a folder on your computer.
3. Run Setup.exe, by right-clicking it and selecting Run as Administrator, which automatically
launches the other installers in succession.
Note If you need the Document Transformation Thin Client for manual document validation after
transformation, see Install Thin Client Server .
4. In the main Kofax RPA installer, select Typical and let it finish the installation.
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5. In the Document Transformation installer, enable all components (default) and let the installer run
until you see the Kofax License Utility window.
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6. Switch to the Kofax License Utility window and select File > Activate. In the Activate window,
enter the serial number and product code that you have, and click Automatic.

The Kofax License Utility is refreshed to list the available licenses. Close the window.
7. Let the installer wizard run until it is finished and click Finish on the last step.
8. Start the Management Console by selecting Start Management Console 10.6.0.0 from the Start
menu.
The console window displays a series of status messages, and then the Management Console is
started. Disregard cluster registration retries but wait for them to resolve. When started successfully,
HTTP Connector started on port 50080 is displayed. Do not cancel or close the console window.
This initial startup may take several minutes.
9. Open a browser window and navigate to http://127.0.0.1:50080/. You should see the EULA
and be asked to input the Kofax RPA license information you were provided with this version.
Complete the license activation by filling in the requested information. When activated, your Kofax
RPA license information is displayed.
10. After a successful activation, the Management Console is opened in the browser window. You can
close the browser.
11. Click the Management Console command window and press CTRL+C to shut it down. This step may
require pressing CTRL+C twice.
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12. To enable the Document Transformation Service, run the PowerShell script specific to your operating
system.
Note This script sets up the IIS services required to host the Thin Client. Optionally, you can
manually configure the Thin Client Server by using the procedures in Install Thin Client Server .
The scripts are located in the Kofax DTS installation folder (by default c:\Program Files
(x86)\Kofax DTS).
• EnableDocumentTransformationWindows7.ps1 for Windows 7
• EnableDocumentTransformationWindows10.ps1 for Windows 10
You need administrator rights to run the scripts. Perform the following steps to install the Document
Transformation Service:
a. Start Windows PowerShell with administrator rights.
b. To allow script execution, run Set-ExecutionPolicy remotesigned in the PowerShell.
c. Change the folder to c:\Program Files (x86)\Kofax DTS
d. Execute the appropriate script.
The following text is displayed after the script is executed.

13. Restart your computer.
After the restart, you should see the Desktop Automation Service icon in the notification area:
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14. Right-click the icon and select Configure.

15. In the Desktop Automation Service configuration window, select Single User and specify a token on
the Single User tab. Define any token, such as mySecretToken.

16. Click Save and Restart.
For Kofax RPA you need to configure two websites using the Internet Information Services (IIS) Manager:
one for the Document Transformation Service and the other for the Document Transformation Thin Client
Server.
Default Web server locations:
• C:\Document Transformation\Client
• C:\Document Transformation\Service
Both websites have a Web.config file you need to modify.
Document Transformation Service Web.config
Edit the following settings:
• BatchValidationFolder specifies where to put documents for validation. This must correspond to
the BatchFolder setting in the Web.config file for the Document Transformation Thin Client Server.
• ProjectsFolder specifies where the service looks for Document Transformation projects.
• ValidationService is the default location for the Document Transformation Thin Client Server and it
is used if you have not specified it in the settings for the Open DT Browser step.
• In the Web.config file, replace localhost with 127.0.0.1 if it is not mapped for your operating
system.
Optionally, you can change the TransformationService and ValidationService port numbers.
Web.config file example:

<TransformationService.Properties.Settings>
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<setting name="BatchValidationFolder" serializeAs="String">
<value>C:\Document Transformation\Batch\Validation</value>
</setting>
<setting name="TransformationService" serializeAs="String">
<value>http://localhost:50081</value>
</setting>
<setting name="ValidationService" serializeAs="String">
<value>http://localhost:50082</value>
</setting>
<setting name="ProjectsFolder" serializeAs="String">
<value>C:\Document Transformation\Project</value>
</setting>
</TransformationService.Properties.Settings>
</applicationSettings>

The maximum document size for transformation is 100 MB. Kofax RPA imposes a file size limit for a
transformed document to enable protection against the denial-of-service attacks. You can lower the file
size value to protect against such an attack. To change the document size limit, edit the following two
parameters in the Web.config file.
<httpRuntime targetFramework="4.5.1" maxRequestLength="104857600"/>
<requestLimits maxAllowedContentLength="104857600"/>
Document Transformation Thin Client Server Web.config
In the Document Transformation Thin Client Server configuration file, edit the BatchFolder setting to
specify where the server looks for documents that are sent for validation.
<Kofax.KTS.Backend.Kapow.Properties.Settings>
<setting name="ReportingEnabled" serializeAs="String">
<value>False</value>
</setting>
<setting name="BatchFolder" serializeAs="String">
<value>C:\Document Transformation\Batch</value>
</setting>
</Kofax.KTS.Backend.Kapow.Properties.Settings>

After installation, the built-in projects are located here:
C:\Document Transformation\Projects

Test configuration
Now you are ready to verify that everything works. The Examples folder in the default project contains a
robot to test the Document Transformation Service.
1. Start the Management Console by selecting Start Management Console 10.6.0.0 from the Start
menu. Make sure that HTTP Connector started on port 50080 displays in the command
window. The Management Console acts as license server for Design Studio that uses the license
you activated earlier.
2. Open Design Studio by selecting Design Studio 10.6.0.0 from the Start menu.
In the Enter License Information window, select License Server and click OK.
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3. In the My Projects view, expand Projects > 10.6.0.0 > Examples > Robots and double-click the
TestDocumentTransformationService robot to open it.

4. Select the CLICK HERE FIRST step, and after reading the message, select THEN CLICK HERE.
If you see the "Congratulations, it works!" message in the main window, Document Transformation
is configured correctly on your computer. If you do not see that message, Kofax Technical Support is
available to help you identify the cause. Refer to the Troubleshooting section in this document.

Use the Thin Client locally
To get the Document Transformation Thin Client to work, add a local user group KTSUsers by following
these steps:
1. Open the Run window by selecting Start > Accessories > Run.
2. In the Run window, type compmgmt.msc and click OK.
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3. Expand Local Users and Groups in the left pane, right-click Groups, and select New Group.
4. Type KTSUsers in the Group name field, and click Add.. under members.
5. Add your own user into the new local group.
Now you should be able to log in to the Document Transformation Thin Client with the added user
credentials.

Path to local Thin Client
The Thin Client is installed automatically and bound to IP address 127.0.0.1 port 50082. If you want to
use the Thin Client option in the Open DT Browser step, enter http://127.0.0.1:50082 in the Thin
Client URL property when creating or editing this step in the Desktop Automation workflow.

Set up Online Learning
The Document Transformation Service provides a method of using unsuccessful extraction results to
improve documents processed in the future. This feature is based on training the system to "remember"
the layout of a sample document, such as an invoice. By using automatic field completion, manually
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typing or selecting the correct value in the transformed document, you can "train" the system to improve
extraction results for a similar document next time.
You can configure this functionality on the General tab in the Document Transformation Service Project
Settings. By default, this functionality is already enabled for the invoice projects included in your
installation package. When setting up the path to store training documents, ensure that the location
already exists. If the Document Transformation Service is installed on multiple servers, we recommend
that you specify a network shared directory, so the documents can be accessed by all of the servers.
Alternatively, you can make the default "Document Transformation" folder a shared folder and configure
the Document Transformation services, Kofax RPA Document Transformation Service and Kofax RPA
Document Transformation Client, to use the UNC path.
Also, the Document Transformation Service allows you to manually update a project by importing
collected extraction or classification Online Learning data. For more information on Online Learning, see
the Kofax Transformation documentation.
Note For validation purposes, when creating a new project to use with the Document Transformation
Service, we recommend that you add a version number to the project name, such as Project_1. After
importing collected Online Learning data, save this project as Project _2, and so on. This approach
will allow the system to keep using the older project, Project_1, for the document validation. Afterward,
update the respective robots to use the new project (Project_2).
When the validation is completed, you can delete the older project and continue using the newer one
until a new set of learned data is imported.

Troubleshooting
License Utility-related errors
Check to make sure the Kofax License Server service is running. Also try starting the License Utility
application via Start > Kofax > Kofax License Utility and verify your license information displays without
errors.

Transformation Failed or Timed Out error after clicking "THEN CLICK HERE" step of robot
This section lists possible causes of the error.
• Document Transformation Service Scheduler is not running.
• Kofax Licensing Server is not running.
• Web.config file was not properly configured as described in the "Document Transformation Service
Web.config" section of this document.
• Incorrect license was specified for your version.
Installation log files
Kofax RPA creates installation log files in C:\Users\{UserAccount}\AppData\Local\Temp. Review
them for additional help or provide them to Kofax Technical Support when opening a Support Case.
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Install Thin Client Server
The following sections provide instructions for installing Kofax Transformation Modules - Thin Client
Server. For the prerequisites, see the Kofax Transformation Modules Thin Client Server Installation Guide.

Install on Windows Server 2008 R2 with SP1 or higher
This section provides instructions for installing Kofax Transformation Modules - Thin Client Server on a
Windows Server 2008 R2 with SP1 and IIS 7.5.
1. On the workstation where Kofax Capture is installed, shut down any applications (including Control
Panel, virus detection software, and toolbars) that are running.
2. Start the installation by running KTS.msi in the Thin Client Server folder of the product files. If you
are running the installation from removable media, the installation should start automatically.
3. Click Next to install the software.
If IIS is not yet installed, a message is displayed. You can ignore this for now and install IIS at a later
time.
4. Read the End-User License Agreement and, if you agree with the terms, select the I accept the
terms in the License Agreement option, and click Next. Otherwise, click Cancel to exit.
5. If necessary, change the default installation location or folder name, and click Next.
a. Click Change.
6.
7.
8.

9.

b. Browse to, or type the new location, and click OK.
Click Install.
When the installation is complete, click Finish.
Optionally, if upgrading to a newer version of Kofax Transformation Modules - Thin Client Server,
you are notified if there are any merge conflicts. These conflicts need to be fixed before continuing
with the rest of the installation. For more information, see "Resolve Upgrade Conflicts" in the Kofax
Transformation Modules Thin Client Server Installation Guide.
Configure the Kofax Transformation Modules - Thin Client Server Web site using the Internet
Information Services (IIS) Manager:
a. From the Connections pane, expand the Sites folder.
b. Right-click the Default Web Site and select Add Application from the menu. This launches the
Add Application window.
c. Type an Alias for your application, such as "ThinClientServer."
d. Select an Application pool. The DefaultAppPool is selected by default and click OK.
e. Browse to the location where you installed Kofax Transformation Modules - Thin Client Server
in step 5 to set the path for this website, and click OK.

10. From the left Connections pane, select your newly added site a second time. A list of features is
displayed in the middle pane.
a. From the IIS section, double-click the Authentication feature. A list of authentication types is
displayed in the middle pane.
b. Select the ASP.NET Impersonation option and ensure it is Disabled.
c. Restart the World Wide Web Publishing Service.
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11. To install the version v4.0.30319 of ASP.NET, open a Command Prompt window that is "Run as
administrator."
a. At the prompt type %windir%\Microsoft.NET\Framework
\v4.0.30319\aspnet_regiis.exe -i and press Enter.
ASP.NET is installed. Close the Command Prompt window.
12. In IIS, click the Application Pools option above the Sites group. A list of application pools is
displayed on the right.
a. Right-click the application pool you selected when adding your application and select
Advanced Settings. The Advanced Settings window is displayed.
b. Under the Process Model group, set the Maximum Worker Processes option to 1. This is the
default setting.
c. Optionally, if you are using an encrypted file system, you also need to click the Identity option
that currently says NetworkService, and change it to a custom account. This custom account
needs to have the same permissions as the NetworkService account.
Click the button to the right of NetworkService. The Application Pool Identity window is
displayed.
Select the Custom account option, and click Set.
Type a User name, Password, and Confirm password, and click OK.
d. Click OK to close the Application Pool Identity window, and again to close the Advanced
Settings window.
e. Double-click the selected application pool.
The Edit Application Pool window is displayed.
f. From the .NET Framework version list, select .NET Framework v4.0.30319.
g. Click OK to close the Edit Application Pool window.
13. If you are running a 64-bit operating system, set the following settings:
a. Click Advanced Settings on the shortcut menu by right-clicking on the application pool used in
your application.
b. Set the Enable 32-bit Applications option to True in the General Settings and click OK.
14. Ensure that the IIS user account IUSR is part of the IIS_IUSRS group and grant that group full
control for <install drive>:\ProgramData\Kofax\CaptureSV.
Note Since the Thin Client Server is a Kofax Capture custom module, the IIS user requires the
same user permissions that are needed to run a Kofax Capture module.
15. Open Services and ensure that the World Wide Web Publishing Service is set to start
automatically.
16. Test that Kofax Capture users can connect to the server by going to http://
localhost/<VirtualDirectory>/ValidationLogin.aspx, http://localhost/
<VirtualDirectory>/VerificationLogin.aspx, or http://localhost/
<VirtualDirectory>/CorrectionLogin.aspx.
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Install on Windows Server 2012, 2012 R2, and 2016
This section provides instructions for installing Kofax Transformation Modules - Thin Client Server on a
Windows Server 2012, Windows Server 2012 R2, and Windows server 2016.
You can install the Kofax Transformation Modules - Thin Client Server by following these steps:
1. On the workstation where Kofax Capture is installed, shut down any applications (including Control
Panel, virus detection software, and toolbars) that are running.
2. Start the installation by running KTS.msi in the Thin Client Server folder of the product files. If you
are running the installation from removable media, the installation should start automatically.
3. Click Next to install the software.
If IIS is not yet installed, a message is displayed. You can ignore this for now and install IIS at a later
time.
4. Read the End-User License Agreement and, if you agree with the terms, select the I accept the
terms in the License Agreement option, and click Next. Otherwise, click Cancel to exit.
5. If necessary, change the default installation location or folder name, and click Next.
a. Click Change.
6.
7.
8.

9.

b. Browse to, or type the new location, and click OK.
Click Install.
When the installation is complete, click Finish.
Optionally, if upgrading to a newer version of Kofax Transformation Modules - Thin Client Server,
you are notified if there are any merge conflicts. These conflicts need to be fixed before continuing
with the rest of the installation. For more information, see "Resolve Upgrade Conflicts" in the Kofax
Transformation Modules Thin Client Server Installation Guide.
Configure the Kofax Transformation Modules - Thin Client Server Web site using the Internet
Information Services (IIS) Manager.
a. From the Connections pane, expand the Sites folder.
b. Right-click the Default Web Site and select Add Application from the menu. This launches the
Add Application window.
c. Type an Alias for your application, such as "ThinClientServer."
d. Select an Application pool. The "DefaultAppPool" is selected by default and click OK.

e. Browse to the location where you installed Kofax Transformation Modules - Thin Client Server
earlier in step 5 to set the path for this website, and click OK.
10. From the left Connections pane, select your newly added site a second time. A list of features is
displayed in the middle pane.
a. From the IIS section, double-click the Authentication feature. A list of authentication types is
displayed in the middle pane.
b. Select the ASP.NET Impersonation option and ensure it is Disabled.
c. Restart the World Wide Web Publishing Service.
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11. Click the Application Pools option from the Connections pane. A list of application pools is
displayed on the right.
a. Right-click the application pool you selected when adding your application and select
Advanced Settings.
The Advanced Settings window is displayed.
b. In the General group, set Enable 32-Bit Applications to True.
c. In the Process Model group, set the Maximum Worker Processes option to 1. This is the
default setting.
d. Optionally, if you are using an encrypted file system, you also need to click the Identity option
from the Process Model group and change it to a custom account. This custom account needs
to have the same permissions as the NetworkService account.
Click the button to the right of Identity value. The Application Pool Identity window is
displayed.
Select the Custom account option, and click Set.
Type a User name, Password, and Confirm password, and click OK.
Click OK to close the Application Pool Identity window, and again to close the Advanced
Settings window.
e. Double-click the selected application pool.
The Edit Application Pool window is displayed.
f. From the .NET CLR version list, select .NET Framework v4.0.30319.
g. Click OK to close the Edit Application Pool window.
12. Ensure that the IIS user account IUSR is part of the IIS_IUSRS group and grant that group full
control for <install drive>:\ProgramData\Kofax\CaptureSV.
Note Since the Thin Client Server is a Kofax Capture custom module, the IIS user requires the
same user permissions that are needed to run a Kofax Capture module.
13. Open Services and ensure that the World Wide Web Publishing Service is set to start
automatically.
14. Test that Kofax Capture users can connect to the server by going to http://
localhost/<VirtualDirectory>/ValidationLogin.aspx, http://localhost/
<VirtualDirectory>/VerificationLogin.aspx, or http://localhost/
<VirtualDirectory>/CorrectionLogin.aspx.

Install on Linux
Kofax RPA provides two installers for Linux:
• A tar.gz file containing all the components.
• Kofax RPA RoboServer installer: Installs the roboserver service only.
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Full Installation
The installation is performed by extracting the contents of the tar.gz file. In most Linux distributions, this
can be done by right-clicking the file and selecting the appropriate extraction option. The file can also be
extracted from the command line as follows:
$tar xzf Kofax_RPA_10.6.0.0_x64.tar.gz

Alternatively, to extract the file to a specific directory, use the following command:
$tar xzf Kofax_RPA_10.6.0.0_x64.tar.gz -C /destination_directory

When the file is extracted, run the following commands as a user with root privileges. The commands help
to manage chrome-sandbox file permissions and set the creator and owner of chrome-sandbox as the
root to enable SUID mode.
• chown root:root chrome-sandbox
• chmod 4755 chrome-sandbox
Proceed to enter license information as described in Provide License Information.
Note You can install Kofax RPA as an unprivileged user on Linux.
Running RoboServer Installer
The RoboServer only installers are created for the deb and rpm packages. The default installation folder
for these packages is /opt/Kapow/.
Each of the RoboServer packages contains a RoboServer launcher that is used to run RoboServer as a
Linux /etc/init.d service. This makes it automatically start on system boot.
The packages create a Kofax RPA user and group in the system used when running the RoboServer
/etc/init.d service. The configuration files (most importantly roboserver.settings) for the
RoboServer service are located in the Kofax RPA users home directory (/home/<username>/) under
the hidden directory .Kofax RPA/<version>.
The roboserver.settings file can also be accessed through /etc/opt/Kapow/
RoboServer.conf.
To see all available commands, just run RoboServer from /etc/init.d without any arguments.
By default, the RoboServer starts with an SSL port listening (the port number is defined in the
roboserver.settings file). Keep in mind that this is a RoboServer only installation; it is not possible
for the service to be configured to start a Management Console, such as with the -MC parameter, which is
done via the full installation of Kofax RPA.
To run roboserver as a init.d service:
1. Install the RPM or DEB package.
2. Change the RoboServer configuration (optional).
3. Run #service RoboServer start, or restart the machine to start the service automatically.

Silent Installation on Windows
A silent installer runs without user interaction. This is convenient if, for instance, you need to automate the
installation process in a script.
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Using Full Installer
To perform a silent installation of Kofax RPA, run the following command with administrative rights.
Note that commands are specified for the 32-bit installer versions. For 64-bit versions, use the same
commands.
msiexec /qn /i Kofax_RPA_10.6.0.0_x32.msi

This command installs the program to the default location. To specify another location, use a command as
follows:
msiexec /qn /i Kofax_RPA_10.6.0.0_x32.msi INSTALLDIR="dir"

where "dir" is the location where you want to install. For example:

msiexec /qn /i Kofax_RPA_10.6.0.0_x32.msi INSTALLDIR="C:\Kofax_RPA 10.6.0.0 x64\"

To specify a file to log the installation process, use the following parameter:
msiexec /qn /i Kofax_RPA_10.6.0.0_x32.msi /l msilog.txt

After installation, proceed to enter license information as described in Provide License Information.
Using Limited Installers
The following are examples of using different installers in silent mode.
msiexec /qn /i Kofax_RPA_DesignStudio_10.6.0.0_x32.msi
msiexec /qn /i Kofax_RPA_RoboServer_10.6.0.0_x32.msi

msiexec /qb /i Kofax_RPA_DesktopAutomation_10.6.0.0_x32.msi

Important Folders in Kofax RPA
We recommend that you become familiar with the folders and files described in this section.
Installation Folder
The installation folder is the folder where Kofax RPA is installed. On Windows, the installation folder
defaults to:
C:\Program Files\Kofax RPA 10.6.0.0
On Linux it will be a directory named Kofax_RPA_10.6.0.0 in the directory where you extracted the
archive.
The installation folder contains the following important folders:
bin
Contains all executable programs for Kofax RPA.
API
Contains files related to the Kofax RPA Integration APIs.
lib on Windows and lib/jdbc on Linux
Contains the installed JDBC database drivers. These drivers are always available in Kofax RPA
applications. Normally, you should manage JDBC drivers as described in the Database Drivers topic
in the Management Console section of the online help.
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Project Folder
The project folder contains your library of robots and types, as described in the Design Studio help topic.
Configure the location of the project folder with the Settings application as described in the Working with
Projects and Libraries topic of the Design Studio help. On Windows, the default location is similar to the
following, depending on your Windows version:
C:\Documents and Settings\username\My Documents\My Robots\10.6.0.0
C:\Users\username\Documents\My Robots\10.6.0.0
Default project directory location for Linux:
~/Kofax RPA/10.6.0.0
The project directory must contain a single subdirectory named Library.
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Application Data Folder
The application data folder contains files that are private to the Kofax RPA but which differ for different
users of the same computer. On Windows, the application data folder is (depending on your Windows
version):
C:\Documents and Settings\username\Local Settings\Application Data\Kofax RPA
\10.6.0.0
C:\Users\username\AppData\Local\Kofax RPA\10.6.0.0
Application data directory for Linux:
~/.Kofax RPA/10.6.0.0
To change the location of the application data folder, you can edit the common.conf file in the
installation\bin folder. Add the following two lines:
• wrapper.java.additional.<NUMBER>=-Dkapow.applicationDataFolder="Folder
containing Configuration folder"
• wrapper.java.additional.<NUMBER>.stripquotes=TRUE
Where <NUMBER> is a unique integer.

Make sure that the user running Kofax RPA has read and write access to the folder.
Under normal circumstances, you should never modify or delete files or folders within this folder directly;
the GUI tools should be used instead. The application data folder contains the following important folders:
Certificates
Contains the HTTPS certificates known by Kofax RPA. See the "Certificates" section in the
Administrator's Guide for more information.
Configuration
Contains configuration files, which are maintained as described in the section Configuring Kofax RPA.
Data
Contains the embedded Derby database used by the Management Console (except when installed
as a web application in a Tomcat web server). See "Management Console on Tomcat" chapter in the
Administrator's Guide.
DemoDatabase
Contains the Development Database used in the Management Console Beginner Tutorial, and which
you can also use in "toy projects" during your introduction to Kofax RPA.
Logs
Contains log files.
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Provide License Information
The first step after basic installation is to enter license information. The Management Console in
Kofax RPA can work in two different ways. In a development environment, you enter the development
license information in Design Studio. In enterprise mode, a shared Management Console is used as
a license server. This chapter provides information about the development environment license. See
the Administrator's Guide for using the Management Console as a license server in the enterprise
environment.
Note that it is not necessary to enter license information in RoboServers, as they automatically receive the
necessary license information from Management Console.
To use the Desktop Automation feature, obtain a separate license for this feature from Kofax.

License Keys
There are three different kinds of license key:
Production key
Permits production use of the Kofax RPA system.
Non-Production key
Permits use of the Kofax RPA system for non-production purposes, such as testing and staging.
Developer Seat key
A special kind of non-production key that allows you to run all the Kofax RPA programs on your own
computer as part of the same installation. There are, however, some performance limitations, as this key
is intended to be used only for development or with a trial installation.
Each type of license key describes which Kofax RPA features you have, and how many KCUs you have
purchased. A Developer Seat key always contains 1 KCU, while the two other keys may contain more.
If you have both a Production key and a Non-Production key, you may install them into the same Kofax
RPA system (that is, in the same Management Console). You may also choose to set up one system for
each key. In both cases, you need to set up at least two different clusters (either on the single system or
one cluster on each of the two systems), configured as Production and Non-Production, respectively. The
KCUs in your licenses can then be assigned to these clusters.
Do not use one key in more than one Management Console.
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Concurrent Robot Execution License
The Kofax RPA Concurrent Robot Execution (CRE) licensing centers around a Kofax RPA Robot license,
where the Kofax RPA Robot license controls how many robots can execute on a Kofax RPA RoboServer
at one time concurrently. For example, if an organization is licensed for five Kofax RPA Robots, then five
robots can be executed concurrently.
There is no limit to the number of robots that can be designed and deployed into production, and robots
can be as simple or complex as they need to be. For example, a robot can consist of a few or many steps
that execute a set of business workflow actions, such as inputting and outputting data, transforming data,
writing data to an Excel worksheet or calling a RESTful Service API.
When you add a CRE-based license and you go to the RoboServers tab in the Management Console, you
need to assign licenses to a cluster. For example, if you have 9 licenses that you assigned to a cluster and
there is one RoboServer in the cluster, the RoboServer can run nine robots. If there are two RoboServers,
they can run four robots each, because a CRE license cannot be split. If you start three RoboServers,
each can run three robots.
Kofax RPA licensing is available on a perpetual or annual term basis. Kofax RPA licensing is independent
of the target hardware environment and physical CPUs, and a robot license is not tied to a physical
desktop or virtual machine, allowing you the flexibility to choose cloud-based or on-premise, as well as
virtualized or physical CPU environments.
Learn more about Kofax RPA licensing at https://www.kofax.com/

Kofax RPA Compute Units
Another way to license Kofax RPA is to use capacity-based pricing based on Kofax RPA Compute Units
(KCUs). This pricing model is completely independent of the chosen hardware configuration.
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What are KCUs?
A KCU is a Kofax RPA Compute Unit and is defined as a unit of measure for how many operations (or
steps) a Kofax RPA RoboServer can perform in one second (which is unrelated to underlying server
capacity).
A step is the smallest unit of action that can be performed within a RoboServer. Examples of steps
are loading a web page, writing a data record to a database, or performing a transformation on a data
element.
One KCU represents a total of 5000 KCU points per second. The number of Kofax RPA steps that make
up one (1) KCU depends on the type of Kofax RPA steps involved, as each step consumes a different
amount of the KCU. The steps are divided into groups, and the most important groups are listed here:
1. Steps that both do I/O and execute JavaScript that cost 10,000 KCU points, such as 2 page loads
per second with 4 KCUs
2. Steps that do either I/O or execute JavaScript (but not both) that cost 1000 KCU points, such as 20
Call REST Web Service Steps per second with 4 KCUs
3. Extraction and transformation steps that cost 1 KCU point, such as 40,000 extract or assign steps
per second with 4 KCUs
4. Desktop Automation step that costs 5000 KCU points.
5. Looping in Desktop Automation that costs 5000 KCU points per iteration.
The complete KCU list is available in Design Studio by clicking Help > Show KCU Information.
You should have enough CPU power and sufficiently low response time from the source server.
Note We have empirically measured the average page load time to be 6.7 seconds on a powerful CPU
over the 23,000 most visited web sites.
The total number of KCUs a robot uses can be seen in the Design Studio Debugger Summary information
after running the robot.
Deploying and Assigning KCUs
With KCUs we can deliver the needed computing capacity independent of the target hardware
environment and physical CPUs. This approach allows the flexibility of choosing cloud-based or onpremise, virtualized or physical CPU environments without the need to control the number of allocated
CPUs.
The available KCUs are assigned to the RoboServer Clusters in the Management Console and
automatically distributed among the RoboServers available within the Cluster.

Enter License in Design Studio
If Design Studio is not already started, do as follows:
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Windows
Use the Design Studio item in the Start menu.
To start the Design Studio from the command line, run the following command in the bin subfolder of the
installation folder.
DesignStudio

Linux
Start Design Studio from the command line by launching the DesignStudio program in the bin directory
under the installation directory (see Important Folders in Kofax RPA) as follows:
$./DesignStudio

On the next screen, enter your license information.
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You have three choices, depending on what information you have been provided from the Kofax RPA and/
or your system administrator:
License Server
If your administrator provided you with the URL to a central license server (Management Console)
that administers the license for all Design Studio users, select License Server and enter the URL and
credentials for that server. The license server must be running and have available Design Studio seats in
order for you to use Design Studio. If your policies forbid storing the license server password, clear the
Remember Password option and you will have to type your password every time you open the Design
Studio.
See the Administrator's Guide for using the Management Console as a license server.
Developer License
The developer license is a combined license key for both Management Console and Design Studio. You
can either enter the license key in your local (embedded) Management Console, or use the dialog box in
Design Studio. Whenever you start Design Studio, the Management Console will automatically start as
well.
Trial License
For the trial license you only need to provide the name, email and company. You do not enter a license
key. Design Studio starts without contacting the Management Console and with limited capabilities. This
license is intended for short-time use for trial/demonstration purposes.
Normally, Design Studio displays the Enter License Information dialog box only the first time it is started.
It will, however, display this dialog box again if the license server cannot be contacted because it has been
moved, is not running, or is unavailable for another reason.
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Switch Display Language for Management
Console and Design Studio
Follow this procedure to change the display language for Management Console and Design Studio. The
examples in this procedure use the Japanese language.
Note On your computer, ensure that the language setting for non-Unicode programs is set to the
applicable language. The steps to take depend on your operating system.
• If Management Console is run as an embedded component, follow these steps:
1. In the folder {path}\<Kofax RPA_installed_folder>\bin, locate and create a backup
copy of the file common.conf. Open the file with a text editor, such as Notepad. You may need to
run the text editor as an administrator.
2. Locate the setting Wrapper Localization, scroll down to the section Java Additional
Parameters, and then make the following changes as applicable to the desired display language.
# Wrapper Localization
#********************************************************************
# Specify the locale which the Wrapper should use. By default the system
# locale is used.
wrapper.lang=ja_JP # en_US or ja_JP
# Java Additional Parameters
wrapper.java.additional.2=-Duser.country=JP
wrapper.java.additional.3=-Duser.region=JP
wrapper.java.additional.4=-Duser.language=ja

3. Save the changes.
• If Management Console is installed on a stand-alone Tomcat server, follow these steps:
1. In your Tomcat installation, locate and open the file catalina.bat. You may need to run the text
editor as administrator.
2. Locate the setting CATALINA_OPTS and then make the following changes as applicable to the
desired display language.
set CATALINA_OPTS="-Duser.language=ja" "-Duser.region=JP" "-Duser.country=JP"

3. Save the changes.
From the Kofax RPA 10.6.0 folder, run the following shortcuts: Start Management Console and Start
Development Database in the Development Database folder. Leave the Command Prompt windows
open while the applications are running.
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When you start Management Console and Design Studio, the display language is changed to the desired
display language. To switch back to English, close both Command Prompt windows. If required restore the
backup copy of common.conf, and then restart both shortcuts.
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Kofax RPA Initial Configuration
After installing Kofax RPA, configure the installation to suit your needs. Some configuration is done using
the Settings application as described in the "RoboServer Configuration" section of the Administrator's
Guide.
Other configuration tasks, relevant mostly for administrators of the Kofax RPA system, are done via
Management Console, more specifically via the Servers tab, the Projects tab and the Options tab. It is
especially important to set up the necessary RoboServers and clusters on the Servers tab. Refer to the
Administrator's Guide and the Management Console section in the Kofax RPA help for information on
Kofax RPA configuration.
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Kofax RPA Upgrade Guidelines
This chapter includes best practices and important information about how to perform an upgrade to Kofax
RPA 10.4.0 from an earlier version of the product.
To ensure a successful transition to Kofax RPA 10.4.0, we highly recommend that you install it alongside
your existing version of the product on the same computer. This approach gives you the ability to acquaint
yourself with the new product features, while continuing to use the earlier version for a period of time to
perform your daily work. While using both versions in parallel, you can open and test the default project
from the earlier version in Design Studio 10.4.0. Note that if you save the default project in version 10.4.0,
it can no longer be opened with the earlier version of Design Studio.
Important If you use the API in your Kofax RPA environment, the Java and .NET files must be
updated when upgrading Kofax RPA. The new API files are located in the API folder of your Kofax RPA
installation folder, such as C:\Program Files\Kofax RPA 10.6.0.0 x64\API.
General upgrade guidelines
Read the General Upgrade Guidelines topic to learn how to best handle upgrading from one major or
minor version to another.
Upgrade from Assisted Entry to Manual Entry
Read the Upgrade From Assisted Entry to Manual Entry topic if you are upgrading to Kofax RPA10.4.0
and your existing robots use the Call SOAP Web Service step in Assisted Entry mode.
Upgrade a RoboServer service installation
Read the Upgrade a RoboServer Service Installation topic if you are upgrading to a newer version of a
RoboServer service.
Upgrade Document Transformation Service
Read the Upgrade Document Transformation Service topic if you are upgrading to a newer version of
Document Transformation Service.
10.5
Version 10.5 of Kofax RPA is backward compatible with any of the 10.x version. Your 10.x robots will run
in Kofax RPA version 10.5. Follow the "General upgrade guidelines" to upgrade to version 10.5.
Upgrade from earlier versions
If you are upgrading from version earlier than 10.x, consult Kofax support for upgrade guidelines.
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General Upgrade Guidelines
This section explains how to perform an upgrade from one major or minor product version to another.
Although the examples are based on an upgrade from version 10.4 to 10.5, the same information applies
to an upgrade from any 10.x version to another, including 10.4.
Note The process for adding a service pack or fix pack to your installation may require fewer steps. For
more information, refer directly to your service pack or fix pack documentation.
We always recommend testing and validating your business-critical robots when upgrading Kofax RPA. In
this topic, we are presenting a method to upgrade your production system when robots are deployed.
Although Kofax is always committed to making Kofax RPA backward compatible with your already defined
robots, types, snippets, mappings, and the like, it is always a good practice to validate your robots in a
test environment before upgrading your production system. A new version of Kofax RPA may introduce
subtle changes to robot language semantics, timing, website, and automation API compatibility. In turn, it
could lead to unwanted behavior of your robots. Some changes may be due to third-party library updates
required to ensure security, or to software enhancements and revisions.
Note If you use Oracle database for collecting analytics data in Kofax RPA and specify the same
database while upgrading to a new version, you must manually drop and create tables in the database.
See the "RoboServer Log Database" and "Scripts for Creating Database Tables" topics in Kofax RPA
help for details on creating database tables.
To mitigate the transition from one version of Kofax RPA to the next, Kofax RPA allows you to run
RoboServers for different versions in parallel in the same installation environment for a period of time.
That way, you can continue to use the existing version to run robots in a production environment, while
validating them in parallel within a test environment. Once you are satisfied and confident with the results
in the newer test environment, you can transition to the new version for use in production.

Start by upgrading only the Management Console
Upgrading the Management Console without upgrading the RoboServers means getting the newest
features from the Management Console and then adding RoboServers and Desktop Automation Services
with the newest version into clusters at a later time.
In our example, we are upgrading from Kofax RPA 10.4 to Kofax RPA 10.5 and have two RoboServers
running. Notice how the 10.4 RoboServers are successfully connected from the newly upgraded
Management Console.
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If you look at your Desktop Automation Services on the Devices tab, you can see how those are also
seamlessly connected to the 10.5 Management Console.

Create a new cluster
Next step is to create a new cluster to place upgraded RoboServers and Desktop Automation Services in
it.
In our example, we have created a new cluster named Production103 for placing upgraded
RoboServers. We have also upgraded one of the RoboServers and placed it in this cluster.

Likewise, we have upgraded one of the Desktop Automation Services to match the RoboServer version
and placed it into this cluster.
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Move projects to the upgraded cluster
When a project has been validated to work on the newest version, it can then be moved to the new
cluster. This requires changing the cluster related to schedules in the project as in the following
screenshot.

Moving to a new cluster also requires changing the service cluster for REST and SOAP services, and also
for any Kapplets related to robots in your project.
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Remove the old cluster
When all your projects have been validated to run on the newest version and all RoboServers and
Desktop Automation Services have been upgraded and placed into the new cluster, you can now delete
the old cluster.

Important
While a project is running on a cluster with RoboServers from a previous version, your robots can only be
edited with the previous version of Design Studio. As soon as a robot is opened and saved with a newer
version of Design Studio, it is migrated to the format of the newest version (you can see the version/format
of a robot by looking at it in the repository of your Management Console).
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A robot in the repository reveals its version. A 10.4 robot cannot run on a 10.3 RoboServer, but it runs fine
on a 10.5 RoboServer.
If a robot has been edited with the newest version of Design Studio, you can no longer run the robot with
previous versions of the RoboServer. So, if you want to change the robot, you need to either edit it with
the older version of Design Studio or validate it (and other robots in the same project) to work on the
newest RoboServer and bump the entire project to the upgraded cluster.
Also, if you attempt to mix RoboServers from different versions into the same cluster, the robots may
switch from one version to another when they are run.

Keep your projects small
For this method of upgrading to work more efficiently, always try to keep your projects small.

Upgrade From Assisted Entry to Manual Entry
Since version 10.3.0.1 the Call SOAP Web Service step does not support Assisted Entry mode. If you are
upgrading from an earlier version of Kofax RPA, update the step as described below.
1. Open the robot in an earlier version of Design Studio, for example 10.3.0.0. Create a copy of the
robot to ensure that you have a backup and because it is easier to upgrade. In the following steps we
will update the step in the copy of the original robot.
2. Open the copy of the robot in Design Studio, execute it to the Call SOAP Web Service step, and
change the entry mode to Manual Entry.
3. Switch to the original robot. Execute to the Call SOAP Web Service step. Open the Browser Tracer
from the Tools menu or by pressing F12. In the Browser Tracer click the red button to start trace
recording.
4. Execute the Call SOAP Web Service step by clicking the step after it.
5. If the original step has a specified Web Service URL, copy it from the step in the original robot to the
step in the updated robot. Otherwise, select the original robot in the editor to ensure that what you
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see in the Browser Tracer is for that robot. In the Browser Tracer, click the single HTTP event entry,
copy the URL, and paste to the Web Service URL property of the updated step.
6. In the Browser Tracer, click the single HTTP event entry and find the header property called
SOAPAction on the Request tab. The Browser Tracer should look similar to the following example:

Copy the value of the SOAPAction header, switch to the updated robot and paste it to the property
called SOAP Action. To copy the value, double-click the header in the list and copy its value from
the Show HTTP Header dialog box.
7. In the Browser Tracer, find the event again, click the Request Data tab, copy the entire text of the
request, and paste it to the SOAP Request property of the updated step.
8. Ensure that the updated step uses the correct SOAP version by looking at the WSDL file used by
the original step. If this WSDL file uses the namespace http://schemas.xmlsoap.org/wsdl/
soap/, the version is 1.1. If it uses the namespace http://schemas.xmlsoap.org/wsdl/
soap12/, the version is 1.2.
9. Make sure that Output, Options, and other properties on the updated step have the same value as
on the original one.
10. Test the updated robot, save it. Open it in Kofax RPA 10.4.0 and test it.
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11. All the previous steps assumed that parameter values in the step are static, that is, do not depend
on variables. If parameter values in your step are taken from variables, create the value of the SOAP
Request property using an expression instead of a static value.
Start by taking a copy of the request. Change the option from XML to XML from Expression and
paste the request into the Expression text field. This will produce an expression with an error. You
fix this by surrounding it with >> and <<.
Dynamic property values
All the previous steps assumed that parameter values in the step are static, which means they are
hardcoded and do not change during the execution of the robot. If parameter values in your step are taken
from variables, create a value of the SOAP Request property using an expression instead of a static
value.
Start by making a copy of the request. Change the option from XML to XML from Expression and paste
the request into the Expression text field. This should produce an expression with an error. Fix it by
surrounding the request with double greater than and less than signs (>> <<).
For instance, if the value of the parameter zipCodeList is taken from a variable that is also called
zipCodeList, the SOAP Request surrounded by >> << should look as follows (some details are left out).
>><?xml version="1.0" encoding="UTF-8"?>
<soapenv:Envelope ...>
<soapenv:Body>
<ns1:LatLonListZipCode ...>
<zipCodeList xsi:type="xsd:string">90210</zipCodeList>
</ns1:LatLonListZipCode>
</soapenv:Body>
</soapenv:Envelope><<

The value of the zipCodeList parameter in the example is static and equals 90210. To use the value of
the zipCodeList variable instead of the hardcoded value, replace the actual value of the parameter with
the variable name in the following format:
<< + zipCodeList + >>
The code example looks like the following:
>><?xml version="1.0" encoding="UTF-8"?>
<soapenv:Envelope ...>
<soapenv:Body>
<ns1:LatLonListZipCode ...>
<zipCodeList xsi:type="xsd:string"><< + zipCodeList + >></zipCodeList>
</ns1:LatLonListZipCode>
</soapenv:Body>
</soapenv:Envelope><<

Continue this process to replace all parameters with variables.
If a parameter depends on an expression and not just a variable, use that expression instead of the
variable. For example, if a parameter depends on the expression x+1, replace the value with:
<< + (x+1) + >>

Upgrade a RoboServer Service Installation
This section provides details about how to upgrade a RoboServer service.
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Perform the following steps to upgrade your Linux installation of Kofax RPA.
1. Stop the roboserver manually and wait for robots to finish executing (optional).
2. Update the packages.
3. Change the configuration in the new roboserver.settings file (optional).
4. Restart the computer or use RoboServerService start command to restart the roboserver.
Note the following when upgrading Kofax RPA on Linux:
• Upgrading a package replaces all the files in the /opt/Kapow/ directory.

• When you start the upgrade procedure, the init.d service is stopped and replaced with a new
version. The service is stopped immediately without waiting for robots to finish executing. If you do not
want to interrupt the execution of the robots, stop the roboserver manually before upgrading.
• A new roboserver.settings file is created for the new service. The new file is created in /
home/kapow/.Kapow/<release_version>/Configuration/ similarly to the old one. That
means a new directory is created for the new release so that the old configuration file remains intact
in the folder with the older release name. The link to the configuration file in /etc/opt/Kapow/
RoboServer.conf points to the settings file in the last installed release.
• The configuration from the old roboserver.settings file is not transferred to the new one, this must
be done manually.

Upgrade Document Transformation Service
To upgrade the Document Transformation Service, you need to perform the following actions:
• Upgrade the program files and installed IIS services (Kofax RPA Document Transformation Service and
Kofax RPA Document Transformation Client). Upgrading the program files is only required if they reside
on the same computer where the Document Transformation Service is running. By default, the program
files are located in C:\Program Files\Kofax DTS.
• Move created data such as projects, custom configurations, and so on.
Before upgrading, create a backup of your Document Transformation folder, including projects, Online
Learning files, and any custom configuration such as adjustments to Web.config files. By default, the
folder is located on the C drive (C:\Document Transformation). When upgrading, it is important that
you consider the following details:
• Existing batches that are waiting for validation may not work with the newer version. Finish processing
all existing batches before you start the upgrade. Otherwise, batches waiting for validation may not be
processed successfully after the upgrade.
• Remove the existing program files and IIS services. To remove the program files,
uninstall Kofax RPA Document Transformation through the Windows Control Panel. If the
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EnableDocumentTransformationWindows scripts were used to create the IIS services, remove the
created IIS Application Pools, websites, and the installed Document Transformation Service folder.
Note Uninstalling may fail to stop the Document Transformation Service Scheduler. Manually stop the
Scheduler before uninstalling Kofax RPA Document Transformation.
After removing the program files and services, you can use the Document Transformation Service
installer for the newer version. Afterward, use the applicable EnableDocumentTransformationWindows
script to install the new services.
• Manually reapply any custom configuration to the services. Do not copy and paste the older
configuration files as they may not be compatible with the services.
• Manually reapply any custom configuration to the built-in standard projects. Otherwise, you can give the
older projects new names to continue using them in the newer version.
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Quick Start Guide
This chapter explains how to get started using Kofax RPA.
Prerequisites
• The examples below use a standalone Management Console (NOT deployed into Tomcat) and
RoboServer that are on a different computer than Design Studio.
• This chapter assumes you have at least a non-production key for running a Management Console.

Install the software
1. Make sure that the system requirements are met based on the information in Dependencies and
Prerequisites.
2. Install the Kofax RPA software on the computer where you will use Management Console and
RoboServer. Follow the instructions in Install Kofax RPA as applicable for your operating system.
3. Install Design Studio on the applicable computers. Use the installer for the Design Studio
component, as described in the Install Kofax RPA chapter. In this chapter, Management Console is
used for licensing.

Start the Management Console and RoboServer
To start a Management Console and RoboServer in the same Java Virtual machine, either run Start
Management Console from the Start menu on Windows or run the following command from the bin folder
of the Kofax RPA installation folder.
• On Windows: RoboServer -MC -p 50000
• On Linux: ./RoboServer -MC -p 50000
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Notes
• All RoboServer command parameters are listed in the Runtime chapter of the Administrator's Guide.
• You can reach Management Console on http://<ServerNameOrIP>:50080. Additional settings
(different port, HTTPS usage, and so on) are available in the RoboServer Settings application.
• You can start RoboServer on different ports (default is 50000). By default, Kofax RPA registers the
RoboServer on the port specified in the command for this Management Console.
• It is possible to start Management Console and RoboServer in separate JVMs by running the
RoboServer command with separate parameters.
Refer to the RoboServer parameters in the Administrator's Guide.
RoboServer -MC command starts Management Console only.
RoboServer -p 50000 -mcUrl http://ServerName:50080 -cl "Production"
command starts a RoboServer on port 50000 and registers it to the Management Console at
ServerName:50080 under the Production cluster.
• A Kofax RPA environment always has one Management Console that can control multiple
RoboServers. Do not configure multiple Management Consoles to control the same RoboServer.
• It is possible to configure Kofax RPA Management Console and RoboServers to start automatically.
See the Kofax RPA Initial Configuration chapter for more information.

Access Management Console and enter the license key
Use your browser to start the Management Console. Example:
http://MCServerName:50080
The first time you access the Management Console, it prompts for the license key. Make sure that the
keys and the company name match exactly the data you received from Kofax. The license data can later
be replaced in the Management Console > Admin > License tab.
Note Click the Help icon ( ) on any tab to get more information about the open window. The icon is
usually on the top right corner.

Configure Management Console settings
Management Console security settings are configured on the Management Console tab of the
RoboServer Settings application. You can open the application from the Kofax RPA group on the Start
menu or from the bin folder in the Kofax RPA installation folder.
Important It is very important to run the RoboServer Settings application as the same user that runs
Management Console. Otherwise, the changes are not applied.
Change Management Console port: change "HTTP Port Number"
To change the default port number, on the Management Console tab in the RoboServer Settings
application, edit the HTTP Port Number property.
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Enable Management Console authentication (optional)
1. On the Management Console tab, select Enable User Management.
2. Enter the Admin username. This is your initial admin user; you can add additional users and create
groups later from the Management Console itself.
3. Click Enter password and set the admin password.
Note If user management is enabled, check the documentation for the correct way to set the
RoboServer to register to this Management Console. See the "Start RoboServer" section in the Kofax
RPA Administrator's Guide.
Upload JDBC driver
The JDBC Driver Upload option changes the way the JDBC drivers are uploaded. By default, only an
admin user is allowed to upload a JDBC driver and only while accessing the Management Console on
the computer it is running (localhost). If you are accessing the Management Console from a different
computer and if you need to upload JDBC drivers (to use with databases), change this option to Admin
from any host.
More detailed information, including information about the other tabs in the RoboServer Settings
application, is available in the "Runtime" section in the Kofax RPA Administrator's Guide.
Important The Management Console and RoboServer must be restarted for changes done in the
RoboServer Settings application to take effect.

Management Console with authentication
When authentication is set up, the Management Console prompts you for a user name and password.
Enter the user name and password set in the RoboServer Settings application. When you are logged in,
the user name is shown in the top right corner.
Create users and groups
Create new users and groups (or assign users to groups) from Management Console > Admin > Users &
Groups tab.
Note that there is no connection between users/groups and your Active Directory/LDAP/Domain users
and groups. If users change their domain password, it has no effect on the user credentials for the
Management Console.
Although it is possible to integrate Kofax RPA Management Console with LDAP, this is an advanced
configuration that only works when Management Console is deployed as an application in a standalone Tomcat web server. For details, see the Tomcat Management Console topic in the Kofax RPA
Administrator's Guide.
Add users to groups
There are two ways to add users to groups.
• Select a user, click Edit User and use the arrows to add the groups the user should be a member of.
• Select a group, click Edit Group and use the arrows to add members.
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Assign rights to users
Important A user created in the Management Console is able to log in to the Management Console
only if the user is part of a group that has been assigned rights to at least one project.
To assign rights to access projects, follow these steps:
1. Go to Management Console > Admin > Projects.
2. Create a project or open the existing project properties by clicking the Edit icon (

).

3. Go to the Permissions tab and click Add Permission.
4. Select a project role in the Project Role drop-down list.
See "Manage Users and Groups" in Kofax RPA help or in the Kofax RPA User's Guide.
5. Select the group in the Security Group drop-down list.
6. Add other groups if needed and click Save.

Configure Management Console before running robots
JDBC database drivers
Kofax RPA has a default database that can be used for logging (logdb) and for robots to store data
(objectdb). To use this database, start it from the Kofax RPA program group under (Start > Programs)
using Start Development Database. An executable is also available in the bin subfolder in your
installation.
To use a custom database (which is recommended even when testing), do the following first.
1. Check Dependencies and Prerequisites to see the database systems that Kofax RPA supports.
2. Get the JDBC driver for the database. Kofax RPA does not provide these drivers, but you can
download them from the database provider, such as Microsoft, Oracle, or other.
3. Upload the JDBC driver in the Management Console > Admin > Settings > Database Drivers by
clicking the Upload Driver Jar button.
Note If the Upload Driver Jar button is disabled, you might be accessing the Management Console
from a different computer than the one on which it is running and you have not changed the setting
to allow driver upload from a different computer. See "Upload JDBC driver" in the Configure
Management Console settings and change the "JDBC driver upload" to "Admin from any host".
Restart Management Console (the process itself) and the "Upload Driver Jar" button should be
enabled.
4. Click Save to save the JDBC driver in Management Console. You can see it listed under "Database
Drivers."
To use multiple types of databases in the same Management Console, upload the driver they should use.
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RoboServer log database
By default, the RoboServer log database in set to logdb (which can be accessed if you start the
Development database only).
You can configure the RoboServer log database as a custom database. If the user you provide has rights
to create tables in this database, Kofax RPA creates all the tables it needs.
If the user cannot create tables, a database administrator has to create them before the database is
configured as a RoboServer log database. See "Scripts for Creating Database Tables" in Kofax RPA help
or the Kofax RPA User's Guide to get the queries needed to create the log tables (make sure to get the
one that applies to your database type).
Your user must be able to write to these tables.
After the RoboServer Log Database is configured, you can see all the logs in the Management Console >
Logs tab.
Harvest database
Robots can store data in databases or query tables for data. By default, objectdb is used (Development
Database). To use a custom database, follow these steps:
1. In Management Console, go to Admin > RoboServers and open Cluster Settings (click the icon or
right-click the cluster to see the option).
2. Click Databases and then Add a Database.
3. Fill in the information, click Test to make sure Management Console connect to the database, and
click OK to save the settings.
Note The Name option is the name of the mapping, not the database (you specify the actual
database name in the Schema option). The mapping name differs from the database name
and you can keep it different if you do not want robot developers to know the real name of the
database. If security is not a concern, you can keep the mapping name the same as the database
name (less confusion).
Data stored by robots in this database can be viewed from Management Console > Data tab. Only tables
created from types are shown. If a table is created in SQL Manager, you will not see it in Management
Console (even if you have robots configured to query it or add/change data in it).
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Shared Databases (between Management Console and Design Studio)
Management Console can push database mappings created under Cluster Settings to Design Studio
instances. If you have multiple clusters, only one cluster can push database mappings.
To configure Shared Databases, follow these steps.
1. Select which clusters will push the databases: go to Management Console > Admin > Settings >
Design Studio > Shared Databases.
2. Create your database mappings under Cluster settings (see the "Harvest database" topic for details).
3. Assign database mappings to projects as follows:
a. Go to Management Console > Repository > Databases and click New Database Mapping.
b. Fill in the information.
• Mapping Name: It can be the same as the name given when creating the mapping in Cluster
Settings (it can be different too, but might cause more confusion).
• Project: Set to the project where this mapping will be used.
Note Keep in mind project permissions when using authentication (see Management
Console with authentication for details). If a mapping is assigned to a project, only users
with rights to that project will be able to use it (and see its data when opening Management
Console > Data tab).
• Cluster: Must be the same as the one you already set for "Shared Databases."
• Database Configuration: Select the mapping created in Cluster Settings from the dropdown list.
4. After you save these settings, the users that have Design Studio connected to this Management
Console can right-click the Management Console connection under Databases, select Refresh and
have the mapping available as in the following example.

Build Robots
Robots are built in Design Studio. See Enter License in Design Studio for more information on how to start
Design Studio and configure a license for it.
Then see "Tutorials" in the User's Guide for more information about building robots. From any step in
Design Studio you can click the help icon ( ) to open help and read more information about that specific
step.
Design Studio also has a default project (its name is the name of the version, such as 10.6.0.0) where you
can find robot examples for common operations.
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Upload Robots
To upload a robot from Design Studio, right-click the robot under My Projects and select Upload. In the
Upload to Management Console dialog box, select the Management Console and the Project where the
robot should be uploaded.
Notes
• You cannot create a project from the Upload dialog box; it must be created in the Management Console
in advance.
• When using this option, you only need to select the robot. Design Studio automatically sends all the
types and snippets that it uses.
• You can share a project between Management Console and Design Studio by selecting "Remember
this (as a shared project)." You can find more information about shared projects and how to work with
them in the "Projects and Libraries" topic in Kofax RPA help and the Kofax RPA User's Guide.
• You can also upload the robot files directly in the Management Console but you have to select the robot
and each type and snippet one by one. Go to Management Console > Repository tab and you can see
the Add buttons on each tab (Robots, Types, Snippets).

Run robots
Run robots from Repository
Each robot in Repository has a "Run Now" icon ( ). However, only robots that do not require input can be
run this way. If your robots require input, they can only be run by a schedule (by Management Console),
API or REST/SOAP services. See the next sections for more information.
If you have multiple clusters, you will be asked to select a cluster on which to run.
Run robots from a schedule
You can create a schedule from the Management Console > Repository > Robots tab by right-clicking a
robot and selecting Create Schedule.
This automatically adds the robot to the schedule. The other option (easier to use when you want to add
multiple robots to a schedule) is to use the “Add” button on the Management Console > Schedules tab.
Run robots via API
You can see the API icon ( ) in Management Console > Repository > Robots.
Clicking the API icon opens the sample code for Java and .NET APIs that you can use to call this robot.
More information is available in the Kofax RPA Developer's Guide.
Run robots using REST/SOAP
Click the REST/SOAP icons ( / ) in Management Console > Repository > Robots to get a service
example that you can use to call that specific robot.
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